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1 General outline of the tool

1.1 Who are the potential users?

The tool is meant to guide practitioners to information of ongoing and finished
restoration® projects. Basically the users are the water- or river managers, but this can
be regarded in a broad sense. Beside river authorities other actors in the field are also
potential users; scientists on the other hand are urged to share information.

The basic format is a Wiki, well-known from the Wikipedia formula. The system is
designed to facilitate everybody to enter information that will be available
immediately to the community. The information can be added to or changed by
anyone at any given time.

1.2 What information is contained?

Basically, information regarding restoration case studies are the core of the
FORECASTER tool. The case studies are inputted in a geographical (google maps)
and a text database. The latter is a fact sheet containing general data of each case
study. The combination of a geographical image and a fact sheet makes it possible to
make various selections possible, also geographical. Additionally, each case study has
its own wiki page, where the case is described in depth. On this page a description of
the case and information on evaluation results can be found, documents with
background information can be downloaded and pictures can be seen.

Remember, anything relevant can be added, that’s the power of wiki.

1.3 How to read this manual

In the manual, keywords for Menu items or other functions in Windows or Wiki are
always given in Bold. If a series of clicks is required for accessing a certain menu
item, the path towards it is given as File > Save. Meaning the user should click on
menu item File and choose Save. Text you need to input is given in italics.

1.4 Getting started: Registration

Before you are ready to add data to the FORECASTER wiki, you have to register to
be able to login. Press the login / create account link located at the top-right of the
FORECASTER page. Then press create an account and fill in the registration page.
Once you are registered you can create and edit wiki-pages. For adding case studies,
your account must be approved by an administrator to avoid malicious use of the
database-tool. For instructions see the database page in the FORECASTER web tool.

! Restoration is used as the general term, however also rehabilitation and mitigation is meant here.



2 How to wiki

Below, a basic summary is given on wiki-page editing. This chapter is intended as an
introduction for people who are not familiar with using a WIKI, but it can be skipped
by more advanced users. Although it is a general introduction, the examples shown
are taken from the FORECASTER-wiki pages. More information on WIKI editing
can be found on the internet: http://en.wikipedia.org/wiki/How_to_edit

2.1 A wiki page
The homepage of FORECASTER looks like the image below.
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Welcome to the FORECASTER web-hased tool! This is a knowledge and infarmation systemn
relating hydrormarphalogy and ecology of European rivers. The system presents a compilation
of case studies describing the output from restoration and rehabilitation projects and is
intended to help practitioners by presenting experiences about success or failure ofthe
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case study has an associated wiki page containing maps and additional infarmation about the
project site and the outcome of the implementation of the project,
y

The systern also contains wiki pages with general descriptions and backaround information
about:

= European River Typologies

Notice that hyperlinks to pages with information are given in , you can click on
these. Sometimes links appear in red, indicating that the page referred to is still non-
existing.

2.2 Basic wiki elements

Some elements can be found on each wiki page, see image below. Especially the left
hand menu under Forecaster shows links to parts of the contents that can’t be
changed by regular users; secondly the Search function which you can use to search
for keywords of the whole wiki site and thirdly the Toolbox that contains important
links used for updating and managing the wiki.


http://en.wikipedia.org/wiki/How_to_edit

Forecaster
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FORECASTER
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Search

| [ Go ] [ =earch

Toolbox
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Upload file
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Above the wiki pages, every page always has several tabs as shown in the figure
below, sometimes a few more. These tabs are related to the page you see at that
moment and allow the user to interact with the page.

. page I dizcussion I it I history _

= The page tab. Pressing it gives you the contents of the page as it is stored in the
wiki.

= The discussion tab is meant to allow the users to discuss changes made to the
page, or for example to propose changes.

= The edit tab, most important, allows the user to edit the page.

= The history tab shows you the history of the changes made to the page and allows
you to return to a previous version. Also if someone else made the changes! Note
that pages should not be reverted on a whim. It is wise to use the discussion page
to discuss changes other people have made that you disagree with.




2.3 Editing a page

Writing in a wiki is similar as to writing in a word processor. After pressing the edit
tab, you will see this editing screen, see the figure below. You need to log in to make
edits; your user name will be used to log your changes. In FORECASTER, first time
users need to register and your registration will be approved by the administrators.

2 Editing Main Page (section) - Forecaster - Mozilla Firefox |:”E”Zl

Fle Edt View History Bookmarks Tools Help

@ ~ @ 0w [ hetpejiforecaster ontwikkel. gisinbernet rifindex. php?title=Main_Pagesaction=edtasection=1 N7 - | [[C#] secge &l "-EZA

. »
U & : A

A knowledge and information system relating
hydromorphology and ecology of European rivers

page discussion et history

Forecaster Waming: You are not logged in. Your IP address will be recorded in this page's edit history

= Homepage
® Forecaster Project
= River Typology

® Pressures & Measures
® Case studies
® Related Stes

This web-based tool is a knowledge and information system relating hydromorphology and ecology of European
rivers. The system presents a compilacion of case studies describing the output from restoration and

= Contact Information rehabilitation projects aiming at improving the ecological condition of different river systems. This

= Databass & Maps tool has been developed as part of the project '' ' FORECASTER''' which deals with the application of output
from research and case studies on ecological responses to hydro-morphological degradation and

Search rehabilitation.

<hr>

=

Toolbox

= What links here
8 Relsted changes
® Upload fils

= Specisl pages

Please note that all contributions to Forecaster may be edited, altered, or reroved by ather contributors. If you do not want your wiiting to be edited
rercilessly, then do not submit it here

You are also promising us that you wrote this yourself, or copied it from a public domain or similar free resource (see Forecaster: Copyrights for
details). DO NOT SUBMIT COPYRIGHTED WORK WITHOUT PERMISSION!

Summary. ‘f‘ Home*/

[ Save page ] [ Show preview H Show changes ] Cancel | Editing heln (opens in new swindow) =

|%

Done

The buttons (see below) can be used to format the text. If you hover with your mouse
arrow above the button, a text will appear indicating its function.

| Ak ‘::I--‘— o P I P, e R = =t 2 o I 2t || EL| ] rars] F5E]

Just remind that the writing pane is not ‘what you see is what you get’, meaning that
you will see a so-called mark-up language after using the buttons.

For example, you type the text This is Bold and select it. Then using the B button for
bold type, will make your line look like this:

""*"This is Bold"""
After pressing the Save page button you will see the end result:

This is Bold



So, in any case you want to see the end result, just press Save page or Show preview.

Just experiment with the buttons.

2.4 Adding a page

1.

w

First type the words used for the link, i.e. the name of the page. For example:
On the new page you can read ..

Then select the words new page and press the internal link button (@). The text
will change to:

On the [[new page]] you can read ..
After finishing your writing, press Save page

In your page a red coloured link will appear like new page. By pressing that link
you will go to the new page. As it is empty, you will enter it in edit mode.

2.5 Linking to a page

1. The easiest way to link to a page within the tool is to use the internal link button

2.

(@) and add the exact page name of the page you wish to link to between the
brackets. So like this:

[[name of the page]]

Sometimes it may be better to link to the page without having the entire page
name typed out. This is definitely the case for pages with a long page name. This
can be done in the following manner:

[[name of the page | text to display]]

This method of linking is known as the pipe trick. The pipe symbol (| ) can be
found on most keyboards under the same key as the backslash (\).

To link to an external page the external link button (&). You must place the URL
of the site you wish to link to into the brackets and add a text to use as the link
title. The following...

[http://www._example.com link title]

...will show up as ‘link title” with a link to http://www.example.com. Note that
the http:// prefix is mandatory for the link to function properly.



http://www.example.com
http://www.example.com.

5. It should be noted that html coding does not function in its entirety within the tool.
As such it is not possible to link to a webpage by copying the URL into an <a
href="URL”> type construction.

2.6 Using headers

Headers are a good way to structure your text. When using headers the wiki will
automatically create a contents box on the top of the page, so your readers can easily
navigate the page. (Example, see the picture below of the River Typology page).

iy cantributions

U a
A knowledge and information system relating
hydromorphology and ecology of European rivers e

European River T__ypblo_gy

£ general European river typology has been defined applving Systern A ofthe Water Framework Directive @2 |

Altitude Catchment area Geology

1. high: = 800m 1. small: 1010 100 kmE 1. calcareous
2. mid-alfituda: 200 to 800 m 2 medium: =100 to 1000 k2 2. silicenus

3. lowland: = 200 m 3. organic
3. large: =1000 to 10 000 km?

4. verylarge; = 10 000 km?

=

To add a header press the Edit tab to enter edit mode.
2. Use the = sign before and after the word to indicate the level of the header, for
example:

= header level 1 =
== header level 2 ==

3. Look at the other wiki pages and choose your headers similar to the layout of the
other pages. This makes the wiki internally consistent and visually more
appealing.

4. When headers are in place, each header will show an [Edit] link in yellow. By
pressing that link, you will be able to edit that section only. Editing this way is
sometimes more convenient than editing whole pages at a time.

5. Use Save page to view your results.



2.7 Inserting lists

Lists are an effective way of organizing information. It can make a piece of text easier

to read and it can help to organise your text into different levels. Lists are often used

in the reference section of a page. As such what follows is a brief explanation of how

to make lists in wiki code.

1. There are two commonly used types of lists; bullets and numbered lists.

2. Bullet lists are made by putting an asterisk symbol (*) before the text that you
wish to include in the list. Just add a * in front of every line in the list.

3. Numbered lists are made in the same manner, only then by using the number
symbol (#).

4. A list can have multiple levels. A second level of a list can be made by adding a
second symbol before the text. Example:

* line of text
* line of text
** line of text
** line of text
* line of text

The above will display as:

= line of text
= line of text
= line of text
= line of text
= line of text

The same procedure can be used for numbered lists, only then by adding an extra
# symbol. Note that each level of a numbered list has its own numbering.
Example:

# line of text
# line of text
## line of text
# line of text
# line of text

The above will display as:

1. line of text
2. line of text
1. line of text
2. line of text
3. line of text



2.8 Inserting images or documents

Uploading a file

1. First of all you have to be logged in to be able to upload files. Use the log in
feature located at the top right of the wiki page. If you do not have an account yet
you will need to create one.

2. Look for Upload file in the Toolbox are of the left screen menu items. Press it
and the following screen will appear:

special

Use the form below to upload files. To view or search previously uploaded files go to the . (re)uploads are alzo logged in the
. deletions in the

Forecaster

= Homepage 4 ) )
u Forecaster Project Toinclude a file in a page, use a link in one of the following forms:
= River Typology = [[Image:File.jpg11 to use the full version of the file

: zl’ess:‘re:.&Maasures = [[Tmage:File pngl| 200px|thumblleftlalt text]] to use a 200 pixel wide rendition in a hosx in the left margin with ‘alt text’ as description
= Case studiss

» Related Stes = [[Media:File_ogg1l for directly linking to the file without displaying the file

= Contact Informatian
= Dalahase & Maps — Unload file

Source filename: | Browse..
Search 2 =

Maximum file size: 16 MEB

el =T Permitted file types: png, oif, jpg, jpeg, pdf, tut, kml

Destination filaname: |
Toolbox Summary

= Upload file
® Special pages

[ wvatch this page [ Ignore any warnings

Upload file

R
159 1] Mecicwia

w

Press the Browse button and look for the files of interest on your PC. These could
be images or pdf files. Word documents or powerpoints are not allowed, so please
convert to pdf first.

Remember there is a maximum file size (16 MB), if needed this can be changed
by the wiki administrator.

4. Choose a clear Destination filename and enter it. Remember this name!

Enter a Summary, this can help other users with identifying the source or with
performing a quickscan of the contents.

Press Upload file.

o

o

Inserting an uploaded image or file in your wiki page.

1. First go to your wiki page and press the edit tab, or one of the yellow edit links
located on the right at every header.

2. Once in edit mode, press either the Embedded file button ([L) for images or the

File link button (Ll|) for linking to pdf files. These texts can appear in editing
mode:

[[Image:Example.jpg]] (After pressing Embedded file)

[[Media:Example.ogg]] (After pressing File link)

10



3. Now change the Example.jpg or Example.ogg to the filename you want to show
or link to.

4. Press Save page to save the page and view the link.

5. Sometimes it may be more appropriate to display a text that links to the file. This
can be achieved by using the pipe trick discussed in chapter 3.5. Example:

[[Media:Example.pdf | text to display]]

This will lead to only the “text to display’ message being shown as a link; clicking
it will open or download the media file.

6. For more options concerning pictures see:
http://en.wikipedia.org/wiki/Wikipedia:Picture_tutorial

2.9 More information on editing

The WIKI community has elaborate manuals on the internet on the usage of special
and specific functions. Please refer to http://en.wikipedia.org/wiki/How_to_edit for
more information.

11


http://en.wikipedia.org/wiki/Wikipedia:Picture_tutorial
http://en.wikipedia.org/wiki/How_to_edit

3 Adding a case study

For those who are unfamiliar on how to use a wiki, basic instructions are given in
chapter 2. This chapter describes how to enter a case study. The steps in paragraph 3.1
have to be completed only once per case study. Adding information, images and
documents in the wiki can be a continuous effort once the project is online.

Access to the database, and with it the option to add cases, is currently restricted to
authorized users only. If you are interested in contributing to the database you can
contact one of the FORECASTER partners to get authorization to access the database.
Once you have access to the database adding a case study can be done via the steps
described below. Please note that browser stability is only guaranteed with Google
Chrome. It is suggested to use Google Chrome when adding and editing case studies.

3.1 The fact sheet (google maps database)

1. Open the forecaster wiki by using the link: http://forecaster.deltares.nl
2. Go to the left-hand menu, Forecaster, choose Database and click the link
(yellow) open the database. The following screen will appear:

L] i »
. 1Y - 1Y

| A knowledge and information system relating

Y hydromarphology and ecology of European rivers

Forecaster Case Studies
Project

= River Typology
= Pressures

= Measures

= BQE

= HYMOQE

= Related Sites
= Contact Information

Search

(G0 (Sea]

Toolbox

= Upload file
= Special pages

3. Here you can choose to either edit an existing case study by clicking on the name
of the case (e.g. Meers) or Insert new Case Study. You can choose Delete Case
Study to remove it from the database, but only if you originally created the
database entry. Click on Insert new Case Study. The following screen will
appear:

12


http://forecaster.deltares.nl

© o

10.

L 4 -
A knowledge and information system relating

hydromorphology and ecology of European rivers 1

General

Forecaster

Project Name
= Homepage |

= FORECASTER
= Case studies

Author

= Rier Tyl iog D) [o7mann | rddimmiy
» Pressures .|
= Measures Country |- Select - I‘LI
o BOE L
= HYMOGE River Name |
= Database
» Related Sites River typology
= Contact Information = =
Enter project location:

search 2T BN T
[Seaen]

Toelbox

= Upload file
= Special pages

Double-click on the map to indicata project location, drag the marker to change location

Location Latitude:| | Longitude:|

Fill in the fact sheet. This will be used in the wiki and also to enable a google
maps search function.

The Project Name is the name under which the database entry will be filed. Be
sure to choose it in such a manner that it can be found again later (suggestion:
Project name - most important measure of the case).

The Date entry is the date that the case was entered. This needs to be put into the
field in the format dd/mm/yyyy. By default the system inserts the date incorrectly;
namely in the form of dd/mm/yy. To get the date to display correctly it needs to be
entered in manually.

To indicate the Location, either enter the coordinates in decimal degrees
(46.62303) or double click the map and drag the indicator to the right place.
Remember you can zoom and pan using the tools on the left side of the map
and/or the mouse wheel.

Remember: you can tick multiple Pressures and Measures for one case.

After finishing the fact sheet, press the Submit button (at the end of the sheet).
The project is added to the database.

Reopen the project in the database (click Database > open the database > select
Project Name) and tick the box Activate wikipage-button. Next press the
button:

Create wiki page (and OVERWRITE current if exists)
Activate wikipage-button

13



11. The following screen will appear:

Sven Teurlincx y talk || My "y contributions

A knowledge and information system relating
Y hydromorphology and ecology of European rivers B

Forecaster Create Wiki-page: Opijnen - Side Channel

- FORECASTER

= Case studies )
= River Typology =0Opijnen - Side Channel= \\a

= Pressures

o iiksiae <googlemap version="0.9" lat="51.8262299763673" lon="5.31103134155273" z0om="13",

= BQE width="100%" height="400" scale="yes" overview="yes" toc="no" controls="large">
(A) 51.8262299763673, 5.31103134155273</googlemap>

= HYMOQE

= Database <Forecas terlink type="getProjectInfoBox" code="27" /3
= Related Sites

= Contact Information ==Key features of the case study==

Search

==Site description==

==Measures selection==
Search

==Success criteria==

Toolbox
==Ecological response==
= Upload file
= Special pages ==Hydromorphological response==

==Monitoring before and after implementation of the project==

--Socio-sconomic aspectas ]
[ I | @ 4

[ Create Wiki page ] [ Back to switchhoard. Page will not he created ]

)

3l ‘
In this screen the code for the wiki page is displayed. Leave this code as is and
press the Create Wiki page button.

12. The new wiki project page is automatically shown. The main headers (e.g. Site
description) for the case study information are automatically added to the project
page. Do not remove any of these categories. Pressures and Measures are also
automatically listed and linked to in the wiki project page.

13. Note: when deleting a case study, the wiki-pages and the database entry have to be
deleted separately. The wiki-pages can be deleted by a system administrator only.

3.2 Case study wiki page editing

Once the project has been added to the database and a wiki page has been generated it
can be seen in the tool. To find the page go to the left-hand Forecaster menu and
choose Case studies. The following page will be displayed:
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Sven nox [] by talk
A knowledge and information system relating
Y hydromorphology and ecology of European rivers
| il

Forecaster Case Studies et

» Homepage

= FORECASTER
= Case studies

« Rivar Typolsgy = To access the information for each case study, click on the biue balloon
& Hass tas = Use the Filter menu to gelectthe case studies far patticular criteria.

Various representative case studies throughout Europe have been selected to highlight the effeets that hyd ion and ilitation initiatives may have on the ecology of
differant river systems

= Measures
= BOE

= HYMOQE View in Google Earth
= Database

» Related Sites

= Contact Information

Terrain Satellite

[ Show labels

Search Vén Duna - side arm reopening

Toolbox

» What links here
u Related changes
» Upload file

= Special pages

» Frintable version
= Permanent link

[l B

When you click on one of the projects (@) some basic information of the project
will pop-up. More information on the case can by found by clicking on the yellow
link view project wiki page. You can also search for the case study by selecting the
Project name in the page list below the map.

Once you are on the wiki page the information of a case study can be entered below
the corresponding headers which were automatically generated during the creation of
the wiki project page. To do so, click on the [edit] link which is situated at the top-
right of the page and at the right-hand side beside every header. It is also possible to
click on the edit tab at the top of the page. The editing of the page is very similar to
using a word processor. Basic editing tasks are described in chapter 2. Remember: do
not enter any text below the [[Category:Case_studies]] code.

Note: Some elements in the WIKI pages are read automatically from the database.
When you encounter text between "< />" for example ““<Forecasterlink
type="getProjectsForPressures™ code="P05" />"*, do not modify this code. Doing so
could damage the functioning of the page, especially it may deactivate one of the
automatic data feeds. When you lost the code in a case study wiki page, please copy
the wiki page text to a word document and recreate the wiki page. The wiki page can
be recreated by going into the database and repeat the instructions of paragraph 3.1,
points 10 to 12. You can re-enter the text by coping it from your word document.

3.3 Adding images or documents

You can easily add background documents or images to your project wiki page. Refer
to paragraph 2.8 for instructions.

Note: MS Office documents, such as Word and Powerpoint files, have to be converted
to PDF files prior to uploading.

Note: be aware that copyrighted material may be prohibited from online distribution.

15



4 Editing WIKI pages

- Indicate that users can not add or delete pages, only modify contents. They can
suggest to the administrator to add or delete pages.

- modifying contents is easiest by pressing yellow edit buttons

- editing pages in forecaster for endusers: case studies

- editing pages in forecaster for project partners: including measures, pressures, BQE,
HYMOQE

- Indicate general structure of these pages (can be a table)
-- River typologies:
-- Drivers & Pressures:
-- Aim & Measures:
-- BQE's
-- HYMOQE's
- Editing existing case studies:
Te editen:
= Case studies:
Key features of the case study
[edit]Site description
[edit]Measures selection
[edit]Success criteria
[edit]Ecological response
[edit]Hydromorphological response
[edit]Monitoring before and after implementation of the project
[edit]Socio-economic aspects
[edit]Contact person within the organization

[edit]Extra background information

[edit]References

futer more these can be edited:

- River typologies, e.g.
http://forecaster.deltares.nl/index.php?title=River_Typology_in_The_Netherlands

16
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- pressure groups, e.g.
http://forecaster.deltares.nl/index.php?title=Category:01._Water_abstractions

- pressures, e.g.
http://forecaster.deltares.nl/index.php?title=Surface_water_abstraction

- measure groups, e.g.
http://forecaster.deltares.nl/index.php?title=Category:01._Water_flow_quantity_impr
ovement

- measures, e.g. http://forecaster.deltares.nl/index.php?title=Improve_water_retention
- BQE's, e.g. http://forecaster.deltares.nl/index.php?title=Category:Phytoplankton

- HYMOQE's, e.g.
http://forecaster.deltares.nl/index.php?title=Category:Quantity_and_dynamics_of wat
er_flow
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